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Solution Type Selection : HFSS > Solution Type

The University of Texas
ARLINGTON..

I\ 2NSYS Electronics Desktop - Dipole_Demo1 - HFSSDesign1 - 3D Modeler - [Dipole_Demaol - HFSSDesign1 - Modeler] - X
57 File Edit View Project Draw Modeler | HFSS | Tools Window Help _ & x
DM | B 8| 5 Solution Type. [EREANO| £’ | MHMTETEQ |eE|@a)| 5
2R B \ e eBDLoC®E MR I | PN | (N .
Bo@EeE g ; N e || e — PSP :
: Bnalyze All - 5 - -
HET- B E8E Submit Jab...
Project Manager Bl B EditNotes...
=[G Dipole_Demo1* Tl N ‘
& HFssDesign1 (DrivenModal)
(2] Definitions 3D Made! Editor

Set Object Temperature..

Design Settings...

Model >

Boundaries >

Excitations >

Hybrid >

Mesh Operations >

Bnalysis Setup >

Optimetrics Analysis >

Fields >

Radiation >

Results >

Boundary Display (Solver View)

i Drecliggo Prappettsen
Mame [ Value | Unit [ Evaluated Value| Design Datasets...
< >
L
arishles | 0 15 3 (mm)

Message Manager 7 X Progress

5] Hide O Messages || — Hide Progress

Select solution type.

O Type here to

10/10/2017

mims]  Souvik Dubey, 2017



Select Modal > Press OK
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Select Model Unit: Modeler>Units
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Select Model Unit: Modeler>Units>cm>o0k
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Set Dialog Data Entry Mode
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Set Dialog Data Entry Mode

Tools > Options > General Options

The University of Texas
ARLINGTON..

I\ ANSYS Electronics Desktop - Dipale_Dernot - HFSSDesign1 - 3D Modeler - [Dipole_Demal - HFSSDesign1 - Modeler] - x
B File Edit View Project Draw Modeler HFSS | Tools Window Help N
DSM| B (& 9 o _ifoa Edilbrs » ZAB|G L [OSETTO BB |0 A0 .
e L e i > - :
2R _IB| \ Jiswa tibranyTecks IBosCe SER S B | P | O | L
= = Project Toals > - = -
i BAPEREL RIS 2P ||vacuum = f|IModel z|jc ittt
. E Run Seript...
PP 888804
Pause Script
(reE Record Script To File..
*
B[ Dipole_bemot Record Script to Project.. ‘
& HFSSDesign1 (DrivenModaly*
(23 Definitions Open Command Windows
Password Manager..
Options > General Options..
Keyboard Shortcuts.. ]88 HPC and Analysis Options...
Custornizz... Export Options Files...
External Toals..
[l Show Queued Simulations
JE]  Edit Active Anslysis Configuration...
Import Aray from Table..
Job Management >
Calibration Wizard
Layout Links..
Metwork Data Explorer
& x PEmag...
Mame | Value | Unit [ Evaluatsd Valus|
>
L
0 15 3 (cm)

Message Manager B x Progress

Set general options

O Type here to

10/10/2017

ImEms)

5] Hide O Messages || — Hide Progress

Souvik Dubey, 2017

13



Set Dialog Data Entry Mode

The University of Texas
ARLINGTON..

3D Modeler > Drawing > Dialog

)

WY File Edit Wiew Project Draw  Modeler HFSS Tools  Window Help

DSM| B|&|x SEE e i ELeB|or B OTITEQ @B |6 .
N O | A RB DS D® ® P8 | o & | ]| - I

394 000od
i@ R e G R el o G R A A _ 0 | Jvacuum = | |[todel R = C
EET 2 = =
B

Dipole_Demo1* 2B Planes
b HFSSDesignt (DriventModal)* A Lists
(23 Definitions

Options X
General A Draming Data Entry Mode
2D Extractor
Crait Desian " point % Dialog
Circuit Metist Design Use F3{F4 to switch between paint and dialog entry mode
HESS
HFS5 30 Layout Relative Coordinate System Creation Mode
HFSS-IE
Mgl 2D @@ huisfPosttion £ Edler angle
Maxwel 30 Use F3{F4 to switch between axis/position and Euler angle creation mode:
RMxprt Polyline Creation
Simplorer
3D Modeler ¥ nucomatically cover dosed polylines
Properties 2% D
Operation ¥ show measure dislog during drawing
Mame | Value | Unit [ Evaluatsd Valus | Snap .

Display I™ Edit properties of new primitives

Spacediaim Link

Advanced
Layout Edicor
Machines
Model Editor
Netlist & Script Editor
arhematic Frlitor e

Cancel
< >
L
atsbles | 0 15 3 (cm)

Message Manager B X Progress

5] Hide O Messages || — Hide Progress

10/10/2017

vems]  Souvik Dubey, 2017 14



Set Default Transparency to 0.7

Tools > Options > General Options
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Set Default Transparency to 0.7
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Drawing 3D Model
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Drawing 3D Model
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Drawing 3D Model
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Drawing 3D Model
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Drawing 3D Model
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Drawing 3D Model

The University of Texas
ARLINGTON..

Cylinderl_1 created

M\ 2MSYS Electronics Desktop - Dipole_Dema - HFSSDesign1 - 30 Modeler - [Dipole_Dema? - HFSSDesign - Modeler] - X
B File Edit “iew Project Draw Modeler HFSS Tools MWindow Help - 8 x
DEH| BB & X  iltocal -lBR e BEZsB(P. T iMCSESEQ %% QA L

2B BB B8R LwIAE oo ocd [eB Do 0Ce LS N A P | ™ inrBE@

GBHRE LGOI 26 W paZ Lt i (B fawun  <|fvoan o] 4o« (@0 e gy L

S HEEOOEO0E0 .

=-{z] Dipole_Demo1* EE_ K
& HFSSDesign1 (DrivenModal)*
(2 Definitions

CreateCylinder
Duplicatefrounc

Lz, Coordinate Systems

&8 Planes
D Lists

Properties 7 x

Name [Value[ Unit | Evalusted Vale |

Mame

“va. "vacuum’

Material
Sovelnside| v
Drientation  Global
Model ~
Displaywi.. [~
Calr =

Transparent 0.7

Altibute < > 0 15 3 (em)

R X Progress

Message Manager

(5] Hide 0 Messages J| = Hide Progress

10/10/2017 fmems) Souvik Dubey, 2017

22



Assigning Materials
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Assigning Materials
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;-3 Mame Location Origin Hela.tilw.a Flelativn.e. i
Permittivity Permeability Conc
cazt_iron SysLibrary I aterialz 1 B0 1500000zien
| chromium SysLibram b aterialz 1 1 FEON000zen
[ | cobalt SysLibrary b aterialz 1 250 10000000sie
] COPREr SwsLibrary bt aterials W
corming_glass SysLibrary I aterialz h75 1 0
N cyanate_ester SysLibramy b aterialz 38 1 0
[ | diamond SysLibrary b aterialz 16.5 1 0
| diamond_hi_pres SysLibrary I aterialz b7 1 0
N diamond_pl_cwd SysLibramy b aterialz 34 1 0
[ | Diwpant Tope 100 HM Film [ton) SysLibrary b aterialz 1A 1 0
: Cruroid [tn) SysLibrary I aterialz 2.2 1 0 v
L4 >
View/Edit Matenals... Add Material.. Clone taterial(z) Remove Materniallz) | Export to Librany... |

0k I Cancel | Help
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Create Port

Draw > Rectangle > OK

I\ ANSYS Electronics Desktop - Dipale_Demo? - HFSSDesignT - 3D Modeler - [Dipole_Demal - HFSSDesign1 - Modeler]
B File Edit View Project Draw  Modeler HFSS Tools Window Help

The University of Texas
ARLINGTON..

DEE| | B@E U dER o BE£eR (o 0SS SEC @b |0alo
HENCE B F- A A .ioooceod.ipBBOoC® N B P -]k E
Arc >
I DBPE SR 2 Equation Based Curve ool dh 0 dd I | E B [fecun =l [[Model =] = O+ |B e, =
o SO Rectangle ) E
o dlipse
=] Dipole_Demo1* O Circle
HFsSDesign1 {Driven! il
(2 Definitions © Regular Polygon | CreateCylinder
4 Equation Based Surface 1 Duplicatefrounc
0 B te Systems
B Cylinder
@ Reguiar Polyhedion ﬂ CreateRectangle
£y Cone
O Sphere
© s Cammand | Attriute |
Helix
Spiral .
. Mame | Y alue | Unit | Evaluated Value
Sweep > Command | CreateRectangle
User Defined Prirnitive > -
User Defined Model > Coordinate...| Global
T e Poszition Ocrn ,-pole_rad -port_I/2 Oz, <07, -
Name o Point N
S B = B o . Axiz #
Solve Inside| [ "
Drrvalon | Gl @ Region Width 2"pole_rad 0. 2cm
Madel v
Dislaywi..| [~ Length [l 01cm
Calor =
Tiansparent| 07 |
Atibute a By

Message Manager
=[] Dipale_Demo (C:/Users/sxdd613/Desktop/HFS5/)
= & HFS5Design] (Drivenbodal)
O/, Solve inside’ o object Tylinder" is unset, due to material assignment change. (11:36:17 PM Oct 10, 2017)
i, 'Solve inside for object Tylinder1_1'is unsel, due to material assignment change. [11:36:17 P Oct 10, 2017)

Add a rectangle to the model

Zancel

i Hide 2 Messages || — Hide Progress

H O Type here to search
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Create Port

The University of Texas
ARLINGTON..

Select Rectanglel > (right click) > Assign Excitation > Lumped Port

I\ ANSYS Electronics Desktop - Dipale_Demo? - HFSSDesignT - 3D Modeler - [Dipole_Demal - HFSSDesign1 - Modeler] - X
B File Edit View Project Draw Modeler HFSS Tools Window Help
DEE| BB &S |X D
HEZN AR RN A C O

i Local

=& | | B|o L |
nDOoCod. i RdDACE S @R

iMSEsTe|eE|aa|a .
®|ub|)<\rv‘3n ~|_|&

REDIRY

BBHRE =G E R KE e  ipod b T v | T R I
R FGIE L HEOEATEOD G .

Project Manager LR =07 Solids

=] Dipole_Demo1* E-4% copper

+|- g4 HFSSDesign1 (DrivenModaly* =7 Cylinderl
(2] Definitions ) CreateCylinder
ol Duplicatefraunc
-7 Cylinder1_1
3 Shests
-3 Unassigned
=8
[N Expand All
~ac Collapse &1
g, Coordinate ¢
B Planes Edit >
& Lists

Create 3D Companent..
Assign Material..

Wiew >
Properties...
Create Aray .

Create Open Region ..

erties 1 x

Update Open Region Padding.

Name [Value| Urit | Evalualed Value
Name o Assign Boundary >
Driertation | Global Assign Excitation > Wirave Port..
Model c2 Assign Hybrid > Lumped Port..
Displap Wi..| [ Assign Mesh Operation > Floquet Port...
Color = I ——— N Terminal...
Transparent| 07 | Incident Wave >
L Linked Field >
Voltage...
Current..
Magnetic Bias...
Atribute [ < > é 02 0.4 {cm)

Message Manager
Dipale_Demol (C:/Users/sxdd613/Desktop/HFS5/)

= & HFS5Design] (Drivenbodal)

O/, Solve inside’ o object Tylinder" is unset, due to material assignment change. (11:36:17 PM Oct 10, 2017)
i, 'Solve inside for object Tylinder1_1'is unsel, due to material assignment change. [11:36:17 P Oct 10, 2017)

B X Progress

n a Lumped Port

H o Type here to

Excitation

i Hide 2 Messages || — Hide Progress

. 11:51PM
B9 ey M
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Create Port

A

The University of Texas
ARLINGTON..

Give Name Portl > Next > Integration Line > New Line

Lurnped Port : Modes

Lurnped Port: General X

Mumber of Modes: I‘I

Mame: IF'ort1| Mode

Integration Line I Characteristic Impedance [£0]

Mone

=

Huore
Full Part Impedance

Resiztance: |50 Iohm LI

Reactance: |D Iohm LI

Use Defaults |

Use Defaults |

< Back I Mext > I Cancel

< Back I VS I

Cancel
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Create Port

The University of Texas
ARLINGTON..

Draw New Integration line along the center of the port between antenna arms >
Next > Renormalize all modes to 50 Ohm > Finish

N 215vS Electronics Desktop - Dipole_Dernot - HFSSDesign1 - 3D Modeler - [Dipole_Demo - HFSSDesignT - Modeler] — X
W7 File Edit Wiew Project Draw  Modeler HFSS Tools Window Help

Dl B@(a(xa  fe AnwE iB20R(pL L OSSSEC(RB(00 |2
.| BBEx@Bes [vusad [meesdien0o0eson in]. a0 < -

BB REE VARG Jrimina

i S = I = 5 Y w5
B2 Solids
4B copper
B4 Cylinder!
L1 CreateCylinder
i Duplicatedrounc
P Cylinder] 1

Dipole_Demol*
& HFssDesign1 (DrivenModaly*
{22 Defintions

Lumped Port: Post Pracessing X

Lumped Port ; Modes X
© DoMothR i
Number of Modes; o HotFienomalze
& Renomalize AllModes
Integration LY Characteristic Impedance [Zo] Full Port Impedance: |50 ohm ~
D
I~ Deembed

Name [value| Urit | Evaluated Value |
Name Rec.
Orientation | Global
<Back Finish Cancel
Modd | v [ Fsh | oo |
Display wi..| [ Use Defaulls
Color =
Transparent| 0.7
< Back Next > Cancsl
L
Attrbute [ < > 0 0.2 {cm)

B X Progre
=[] Dipale_Demol (iU seis/sxdd61 3/Desktop/HFSS/)
£ HFSSDesign (Driverbodal)
- 4, 'Solve inside’ for object Tylinder!” is unset, dus to materisl sssignment changs, (11:36:17 PM et 10, 2017)
424, 'Solve inside for object ‘Cylinder1_1"is unset, due to material assignment change. [11:36:17 P Oct 10, 2017)

i Hide 2 Messages | = Hide Progress
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Create Port

The University of Texas
ARLINGTON..

Port assignment should look like this

I\ ANSYS Electronics Desktop - Dipale_Dernot - HFSSDesign1 - 3D Modeler - [Dipole_Demal - HFSSDesign1 - Modeler] - x
B File Edit View Project Draw Modeler HFSS Tools Window Help NI
‘DEH| 18 |x 2 - o ek e eesn|er |8 ocssta|ei || -,
KB B B8R AV D0 Cod BB DoC@sEeR e & ~o =8 L]
PP ESLHAWABNE WY iwaPah _li o 63 b | F | vacuum = | |[Model RIS e e — [ [
A = = Y
£ Dipole_bemo1* £ copper
& HF5SDesign1 (Driventodal)* B2 Cylinder!
g9 3D Components {1 CreateCylinder
1 DuplicateArounc
B Boundan & Cylinder!_1
B Excitations 1 Sheets
= B2 Lumped Port
& Hybrid Regigns -3 Rectanglel
-8 Mesh Opgéations i1 CreateRectangle
[ Coverlines
B optimetrics 1z, Coordinate Systems
Results B Planes
Part Field Display &2 Lists
Wiy Field Overlays
-5 Radiation
(23 Definitions
Properties a x
Meme [Valus| Urit | Evalusted Valus|
Name Portl
Type Lum —-
Resistance (50 ohm  50chm
Reactance (0 ohm  Oohm
Num Modes |1
Desmbed | [
Renom AlL.| [v
Renomm..|50  ohm  50chm
i
HFSS < > 0 025 0.5 (cm)

Message Manager
=[] Dipole_Demo [T /Users/sxd3613/Desktop/HF55/)

=g HFSSDesign] [Drivenhodal)
/i, 'Solve inside for object Cylinder" is unse, due to materisl assignment change. [11:36:17 PM_Oct 10, 2017)
O, ‘Solve inside’ for object Tylinder1_1'is unset, due to material assignment change. (11:36:17 PM Oct 10, 2017)

B % Progress

Ready i Hide 2 Messages || = Hide Frogress
1204 AM

B g0
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Create Radiation Boundary

The University of Texas
ARLINGTON..

HFSS > Model > Create Open Region
Enter Operation Frequency and select radiation boundary

I\ ANSVS Electranics Desktop - Dipole_Dermol - HFSIDesign - 3D Modeler - [Dipole_Dernol - HFSSDesignT - Modeler] - X
®° File Edit Wiew Project Draw Modeler HFSS Tools  Window Help -8 %
‘D SIS e W iB2em|or |t o _

9k, B BB BEFES E LPBDoCesen 0| .« Create OpenRegion X

Walidation Check...

: 2 : :
@BBBREUHEGMANGET (B aZ b i [ewom <] |[Moser |

i Pl B RE [ BEEE  sumtiob.

EEIE ] = - Fiegion

=] Dipole_Demo1* Tl N
& HFSSDesign1 (DriventModal)y*
& 30 Componerts 30 Model Editor

&P Viockl Set Object Temperature... Operating Frequency: |E - |I3Hz

EF Boundaries
8 Excitations Design Settings...

Model > Create Array ..

S g P 5 [ Apply infinite ground plane at |Neg 2 direction

#8 Mesh Operations Create Open Region ...

T Arclysis Botetens > Update Open Region Padding..
B optimetrics Hybrid >
Resuts Mesh Operations >
Part Field Display Aalysis Setup N E CIUI"IdEIr_'r'
T Field Overlays .
Optimetrics Analysis >
% Radiation
(3 Definitions il D .
Radiztion > i+ Radiation
Results >

Boundary Display (Solver View)

— " FE-BI

Name [Value| Urit | Evaluated Value Design Datasets...
Name Partl

Tps  Lum i PML —

Resistance |60 ohm Blohm

Reactance 0 ohm Oohm
Num Modes |1
Deembed | [

Rerom .| [+ [ Save as default

Renarm ... 50 obm Sk

k. | Cancel

HFSS < > 0 025 0.5 (cm)

B % Progress

Message Manager
= [3:] Dipole_Demal (T /Users/sd3613/Deskiop/HF55/)

=g HFS5Design] [Drivenhodal)
/4, 'Solve inside for object Cylinder" is unse, due to materisl assignment change. [11:36:17 PM_Oct 10, 2017)
O, ‘Solve inside’ for object Tylinder1_1'is unset, due to material assignment change. (11:36:17 PM Oct 10, 2017)

i Hide 2 Messages

Number of strands [number of wires per conductor), 0 for auto-design = Hide Progress
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A

B File Edit View Project Draw  Modeler

DEH| RB(&|X <
2%

B EXEEBEEE .
BOBRSE UG R e W oD

Create Radiation Boundary

HFSS  Tools  Window Help

Vacuum Radiating Surface Created

[Local

S B N = e R el

Pl @ b 88808000 .

Project Manager 1 x

-] Dipole_pemo1*
=g HFSSDesign (DrivenModaly*
& 30 Components
&P Model
EF Boundaries
&2 Excitations
£ Portl
& vybrid Regions
B8 Mesh Operations
S analysic
Optinvetrics
Results
Port Field Display
T Field Overlays
3 Radiation
-] Definitions

Properties

Name [Value[ Unit | Evalusted Valus [

Name

Material e, “copper”
Solve Inside| [

Otientation | Global

Model ca

Display wi..| [

Color =

Transparent| 07 |

MCETE@ 4B 06 o
:@‘ub‘xv v|su -
g‘va:uum - ‘Model R | k=

The University of Texas
ARLINGTON..

Attribute

Message Manager

= [ Dipols_Demol [C:/Useis/sd9613/Deskiop/HFSE/)

= & HFSSDesign! [DriverModal)

SO, “Solve inside’ for abject Tyindert' s unset, dus to material assignment change. (11:35:17 PM Oct10, 2017)
‘Skve inside for obiact Cylinder]_1'is urset. due to material assignment change. (11:36:17 PM (ict 10, 2017)

Hi

10/11/2017

&7 Solids

=4 copper
5P Cylindert

[ CreateCylinder
-] Duplicatesrount
& Cylindert_1
vacuum
&P RadiatingSurface
3 Sheets

B Lurnped Port
-3 Rectanglel
- CreateRectangle
-~ Coverlines
1, Coordinate Systers
B Planes
& Lists

i Hide 2 Messages

) g1

= Hide Progress
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olution Setup

The University of Texas
ARLINGTON..

HFSS > Analysis Setup > Add Solution Setup

N\ 215vS Electronics Desktop - Dipole_Demo - HFSSDesign - 30 Modeler - [Dipole_Demo - HFSSDesign1 - Modeler] - x
B0 File Edit View Project Draw Modeler HFSS Tools MWindow Help _ & x
DEH L B S r o Soluson Type law e egsBk|e |0 inssssa|ak|a L
e AN \ L tist ‘RDEDoC® ® i@ | s 2| =)o C
— — & ‘Validation Check... : X
GB@R=HE@mMANGE T ! N e | o R = S a-d=l.
HE BB A st
w
=] Dipole_Demot Toalkit N
(=& HFSSDesign1 (DrivenModaly*
g9 3D Components 30 Model Editar
€ Model Set Object Temperature...
£ Boundaries Dasian Satti
esigh Settings...
9 Excitations g 8
- Port1 Model
& Hybrid Regions Boumckits
... Mesh Operations
N Excitations
- fF Analysis
-8 Optimetrics Hybrid
Resuks Wesh Operations
ort: Field Display Analysis Setup £ Add Solution Setup..,
G Field Overlays Optimetrics &nalysis £dd Frequency Sweep...
S Radistion
-2 Definitions Fields ’ List.
fadizioy ’ Revert to Initial Mesh
sl ’ Bpply Mesh Operations
Boundary Display (Solver View) e it B
S——
Design Datasets...
I
< > 0 3 6 (cm)

o X Progress

Message Manager
Dipale_Dema (C:AUsers/sud361 3/ Desktap/HFSS /)

& HFSS5Design! (Diivenhodal)

A, 'Solveinside! for obijest Tylinder] is unset, due to malerial assignment change. (11:36:17 FM Dot 10, 2017)
9.4, "Solveinside’ for object Tylinder!_1"is unset, due ta material assignment change. (11:35:17 PM Oct 10, 2017)

Add a new solution setup. i. Hide 2Messages J| = Hide Progress

O
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Solution Setup

The University of Texas
ARLINGTON..

HFSS > Analysis Setup > Add Solution Setup
Select solution frequency , Maximum Number of Passes 12

A ANMSYS Electronics Desktop - Dipole_Dernol - HFSSDesign - 30 Modeler - [Dipole_DemoT - HFSSDesign1 - Modeler] . . x
7 File Edit Miew Project Draw Modeler | HFSS | Tools Window Help Driven Solution Setup x —= T
iDEHE | B & .| SolutionType R B iB26R|p - |H . i0NC338Q|%%|0 0

General ] Dptions] Advancedl Exprezsion Cache] Derivati\res] Defaults]

2R B | ;.“tw PEDoOE S | P ) e
alidation Check...
GaBRsRFGMAGE, : N e ) T =

HE TS ) B A EE bt Setup Name: Setupl
B s

=5 Dipole_Demo1* Toatiit N [v Enabled [~ Salve Ports Only
(=& HFSSDesign1 (DrivenModaly*
g9 3D Components 3D Madel Editor
& Model :
'@ tonneiries Set Object Temperature... Solution Frequency: |5 |GH2 j

% Excitations Design Settings...

- /Eg} Port1 Madel »
= ) . .
& Hybrid Regions Boundaries N Adaptive Solutions
... Mesh Operations
N Excitations >
- fF Analysis
(B optimetrics Hybrid > b aximum Mumber of Pazzes: 14
Resuls Mesh Operations >
Part Field Display Pnalysis Setup > 0 Add Solution Setup...
. :'Ef_ TVE"EVS Optimetrics &nslysis > #dd Frequency Sweep... f* Manimum Delta 5 002
5P Radistion
- (] Definitions Fields > List..
Radiation ’ Revert to Initial Mesh ™ Use Matrix Canvergence
Results >

Ppply Mesh Operations
Boundary Display (Sobver View)

S
Design Datasets...
E Usze Defaults

Clear Linked Data

HPC and Analysis Options... ‘

1/

Message Manager
Dipale_Dema (C:AUsers/sud361 3/ Desktap/HFSS /)
=@ HF55Design] (DiivenModal]
A, 'Solveinside! for obijest Tylinder] is unset, due to malerial assignment change. (11:36:17 FM Dot 10, 2017)
9.4, "Solveinside’ for object Tylinder!_1"is unset, due ta material assignment change. (11:35:17 PM Oct 10, 2017)

o X Progress

o ]

Cancel |

Add a new solution setup. i. Hide 2Messages J| = Hide Progress
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Solution Setup

The University of Texas
ARLINGTON..

In option tab enter Minimum Number of Passes 4, Solution option Iterative
Solver

I\ 2NSYS Electronics Desktop - Dipole_Demo1 - HFSSDesignT - 30 Modeler - [Dipole_Dema - HFSSDesign - Madeler] - x
B File Edit Wiew Project Draw Modeler HFSS Tools ‘Window Help - & x
DS HE B & = . soutonType lmz @ B B0 | "SS2S EQ ] ]
iaw B | [ List.. leponoe O || oo Driven Solution Setup Y
alidation Check...
GBBREERGDRNE, N e | O m :
o e CHEEE  semis. General  Options ]Advanced Exprezzion Cache Denvatlves] Defaults]
B .
={E Dipole_Dema1* — > Iritial Mesh Options
(=& HFSSDesign1 (DrivenModaly*
g D t: 30 Model Ed i
- ol Editer Iv Dalambda Refingment
ﬂ lode! Set Object Ternperature...
. Boundaries
D Excitations B g Lambda Target: |0.3333 v Usze Default alue
- /Eg} Port1 Madel 4
& ryid Regons B R I Use Free Space Lambda
... Mesh Operations
ﬁ Analysis Excitations >
1B ontimetrics Hybrid > Adaptive Options
esults Wesh Operations >
- F_ﬂrltdzeld")isulav Aalysis Setup P Add Selution Setup.. Mazimum Befinement Per Pazs: i =
% R'Ed_ IVE' s Optimetrics &nalysis > £dd Frequency Sweep...
2 Radiction
£ Definitions Fields > Lt [~ Maxirurm Refinement: 1000000
fadisucy ’ Revert to Initial Mesh
flesult > Bpply Mesh Operations Minirurn Mumber of Passes: 4
Boundary Display (Sobver View) Sl B
P\ i -
Aouetes W Design Propertes.. Minimum Converged Passes: 1
Design Datasets,..
Solution Optiong
Order of Basis Functions: First Order -

" Direct Solver
¥ |terative Salver

Relative Residuat 1e-006

< > 0 " Domain Decompasition

Message Manager
=] Dipole_Demo (C:/Users/sxdd61 3/DesktopHFS5/)

=@ HF55Design] (DiivenModal]
A, 'Solveinside! for obijest Tylinder] is unset, due to malerial assignment change. (11:36:17 FM Dot 10, 2017)
9.4, "Solveinside’ for object Tylinder!_1"is unset, due ta material assignment change. (11:35:17 PM Oct 10, 2017)

0.0007

Use Defaults 1
X /2017 m
10/11/2017 — —

Add a new salution setup.

Dubey, 2017
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Add Frequency Sweep

The University of Texas
ARLINGTON..

Right click on newly created Setupl from Analysis tab of project manger and add
Frequency Sweep > Provide the start, end and step size as 3, 7 and 0.01 GHz

N BHSTS Electronics Desktop - Dipole_Dermo - HFSSDesignT - 30 Modeler - [Dipole_Dema’ - HFSSDesign] - Modeler] - X
®° File Edit View Project Draw  Modeler HFSS  Tools  Window  Help - & %
iD= BE|& (X2 i Rl AN O R - LR ICr B Mt @l Gial @l
i B | l~nsne loocood a8 @a o
BRI 87 LD . L 2| Edit Frequency Sweep >
B AWM E = LR 2 e A L L
HEMETRE R i O i Y
TP Selc: General l Interpolation ] Defaultz ]
&[] pipole_Demo1* 1 &F copper
=1 g HFSSDesign1 (DrivenModal)* -7 Cylinder]
= 5 CreateCylinder
& 30 Components L.J ¥l
B e ) Duplicateroun: Sweep Mame: |5weep v Enabled
F Boundaries P Cylinder1_1
/89 Exchations &1 & vacuum
LA Fortl i ;dlatmgSurface S T
5 L) CreateRegion . ;
& Hyord Regions g WeE = |Inter olatin -
BB Mesh Operations (=3 Sheets PP p d
1 sockyss 5 2 Lumped Por
L EE P Bactangled ) .
o, ® Cory CUlE yepteRectangle Frequency Sweeps [41 points defined]
[T resut BB Paste Sl Soverlines
ort Fi Systemns AL S
R o 2“'" . ‘iz Diskribution
g Radiat eete e
(-1 Definitions Properties..
Disable Setup
|~ Add Frequency Sweep..
Name Subrmit Job...
Name |Set. Revert ta Initial Mesh
Enabled 2 Add Mesh Linked Salution Setup Add Above Add Below Prewview ...
Passes |12 Apply Mesh Operations
Percent R |30 e tired
it
Soldion Fr.. 5 s Hinea
DetaS 002 Create Quick Report..
Basis Dider |Fist Perforrn FFT on Report .. i I i1
MasRefn.. 100 A ——— Time Dormain Calculation. .
UseMax . | [
UseadC. | [ Prafile...
Solver Type |tera... Convergence...
IE Sohver .. |Auto hatriz Data
Mesh Statistics...
Metwark Data Exglarer...
HFs3 |« B
= [ Dipole_Demal IC: AUsersswd381 3/Diesktan/HFS5./)
=18 HFS5Designl [Diiventodal)
52/4h "Salve insids’ for object Cylinder"is unset, due to material assignment change, (11:36:17 PM 0ct 10, 2017)
i Sclve inside’ for object Cylinder! _1"is unset, due Io material assignment change. [11:36:17 P Oct 10, 2017) |:|K Ear‘u:el
Add a new frequency sweep to this setup. Hide: 2 Messages

1222 AM
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Save and Validation

Save the project > HFSS > Validation Check

N\ 215vS Electronics Desktop - Dipole_Derno - HFSSDesign - 30 Modeler - [Dipole_Demo - HFSSDesign1 - Modeler]
B File Edit Wiew Project Draw Modeler HFSS Tools Mindow Help

el B2 & c Solution Type
iRk | Lot
N o Validation Check...
: d 05 Analyze Al

e il P EEE submitib.
Bt
=[] Dipole_Demo1 —

[=-& HFSSDesign1 (DriventModal)
g9 3D Components
€ Model

£F Boundaries

A Excitations

-/ Port1

. Hybrid Regions
... Mesh Operations

SF analysis

- P Setupl
{8 optimetrics

[ Port Field Display
.. Field Overlays

S Radiation
-] Definitions

Name  [Vaue[ Unit [ Evalusted Value |

Name Set
Enabled [V
Passes 12
PeicentR... 30
SolufionFr.. 5 |GHz
DeltsS 002

Basis Order st
M Fiefin... 100.
UseMax.. [
UsedBC... [~
Solver Type liera
IE Solver... Aulo

HFSS

Message Manager

=] Dipole_Dema (C:/Users/s#361 3/Desktap/HFS5/)
- HFSSDesign! Diivenhodal)

3D Model Editar
Set Object Temperature...
Design Settings..

Model
Boundaries
Excitations

Hybridt

Mesh Operations
Bnalysis Setup
Optimetrics Analysis
Fields

Radiation

Results

Boundary Display (Sobver View)

Design Praperties...
Design Datasets...

INER=RNONE
. BEBDOLHC®

ZLB|PLr|BMSTISEQ B @0 D
R;i@lnbl)ﬁ"in ';5 5
‘va(uum - ‘Mnde\ |- i E

0 - [

The University of Texas

ARLINGTON.-.

y HF5SDesigni

" alidation Check. completed.

Walidation Check: Dipaole_Dernal - HF33Design

" Design Settings

« 30 Model

¥ Boundaries and Excitations
¥ Mezh Operations

¥ fnalysis Setup

<« Optimetrics

" Radiation

4 'Solveinside for object ‘Cyinder" is unset, due to material assignment change. [11:36:17 PM Oct 10, 2017)

Perform validation check on design setup.

2 0

e here il

10/10/2017

4, "Solve inside for object Cyinder1_1"s unset, due to material assignment change. [11:36:17 PM Oct 10, 2017)

4 o

0 3 6 (cm)

R X Progress

i Hide 2 Messages
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Run Simulation

The University of Texas
ARLINGTON..

HFSS > Analyze All

A ANSYS Electronics Desktop - Dipole_Dernol - HFS3Design1 - 30 Modeler - SOLVED - [Dipole_Demo1 - HFSSDesigni - Modeler] -
W7 File Edit Wiew Project Draw Modeler HFSS Tools Window Help

DSHE| & | | selution Tpe., A% e iB2LB(Pr B 0SS SQ @@ 00|20,
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BBBREEHEAUBNN Y A s || e = P [
HET iEH B EE suwmitlob.

Project Manager LY 1B Edit Motes

=2 Dipole_Demo1*

Toolkit >
=g HFSSDesign1 (DrivenModal)®™
& 3D Components 30 Model Editor
& Madel Set Object Temperature,..
£ Boundaries
Design Settings...
22 Excitations
i D Partl Model >
-
& Hybrid Regions Boundaries 5
B8 Mesh Opersations .
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Hybrid >
Wesh Operations >
Analysis Setup >
Optimetrics Analysis >
T Field Overlays
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Results 5

Baundary Display (Sabver View)
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) Nomal completion of simulation on server: Local Machine. [12.28:44 AM 0ot 11, 2017)
) Solution Setup] : Sweep, interpolating sweep converged and passive within tolerance at all sampling iequencies. (12:28:16 AM Det 11, 2017)
b Namal completion of simulation on server: Local Machine, (122315 AM Oet 11, 2017)
b Solution Setup] : Sweeg, interpolating sweep converged and passive within talerance at al sampling hequencies, (12:23:24 AM Det 11, 2017)
) Nomal completion of simulation on server: Local Machine. [12:28:24 AM Oct 11, 2017)
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Simulation in Progress
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WP Solution Setup! : Sweer', interpolating sweep converaed and passive within tolerance at all sampling frequencies. (12:29:16 AM Det 11, 2017)
D Nomal completion of simulation on server; Local Machine. (122815 AM Oct 11, 2017)
b Solution Setupl - Sweep. interpolating sweep converged and passive within tolerance at al sampling hequencies. (12.23:24 A Dot 11, 2017)

Solving matis part 1 of 2

&P MNomal completion of simulation on server: Local Machine. (12:23:24 AM Oct 11, 2017)
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Simulation in Progress
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View Results (log magnitude) %

The University of Texas

ARLINGTON..
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View Results (log magnitude)

The University of Texas
ARLINGTON..
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Message Manager
) Namal completion cof simulation on server: Local Machine, (12:30:41 AM Oct 11, 2017)
) Solution Setupl : Swesp!. interpolating swesp converged and passive vithin tolerance at all samping frequencies. (12:31:22 AM Oct 11, 2017)
) Nomal completion cof simulation on server: Local Machine. (12:31:22 M Oct 11, 2017)

4, Check the race 'dB(5[Fort] Fort1]J,  may have been edited indiectly due to the edit. 1258:14 AM Oct 11, 2017)

@ Soluion Setupl : Sweep’, interpolating sweep converged and passive vithin talerance t all samping frequencies. (12:56:54 AM Oct 11, 2017)

& Hide 17 Messages 1 ™ Hide Progress
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View Results (phase)

The University of Texas

ARLINGTON..
Results (right click) > Create Modal Solution Data Report > Rectangular Plot
S parameter > S(Portl, Portl) > and_deg > New Report
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R X Progress

Message Manager
b Nomal completion cof simulation on server: Local Machine, (12:30:41 AM Oct 11, 2017)

b Solution Setup] : Swesp interpolating sweep converged and passive within tolerance at all sampling hequencies. (12:31:22 AM Dot 11, 2017)
) Nomal completion cof simulation on server: Local Machine. (12:31:224M Ogt 11, 2017)

4, Check the race 'dB(5[Fort] Fort1]), i may have been edited indirectly due o the edit. [12.58:14 AM Oct 11, 2017]

i Soluion Setup] : Sweer, interpolating sweep converged and passive within talerance at al sampling hequencies, (125854 AM Det 11, 2017)
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42



View Results (phase
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b Nomal completion cof simulation on server: Local Machine, (12:30:41 AM Oct 11, 2017)

b Solution Setup] : Swesp interpolating sweep converged and passive within tolerance at all sampling hequencies. (12:31:22 AM Dot 11, 2017)
) Nomal completion cof simulation on server: Local Machine. (12:31:224M Ogt 11, 2017)

4, Check the race 'dB(5[Fort] Fort1]), i may have been edited indirectly due o the edit. [12.58:14 AM Oct 11, 2017]

i Soluion Setup] : Sweer, interpolating sweep converged and passive within talerance at al sampling hequencies, (125854 AM Det 11, 2017)
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View Results (smith chart) Ao
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I
Solution Data. 350
Tune Reports ..
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View Results (Far field report)
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ARLINGTON..
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View Results (Far field report

The University of Texas
ARLINGTON..
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Message Manager 2 X Progress
{9 Normal completion of simulation on server: Local Machine. (12:30:41 AM Oct 11, 2017)
Solution‘Setup : Sweep!, interpolating sweep converged and passive within tolerance at all sampling frequencies. (12:31:22 M Oct 11, 2017)
Normal completion of simulation an server: Local Machine. (12:31:22 AM Oct 11, 2017)
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The University of Texas
ARLINGTON..

Thank You !
Further Queries
souvik.dubey@mavs.uta.edu

Download link:
http://www.souvikdubey.com/hfsstutorial.ntml
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